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1.1 Applicable documents 

This user manual applies in conjunction with the following documents: 

 User manual for the installed version of the BAUR Software 4 

 User manual for the PD-TaD 62 or PD-TaD 80 portable PD diagnostics system 

 Data sheet for the BAUR Software 4 for cable testing and diagnostics 
 

1.2 Structure of safety instructions 

The safety instructions in this user manual are presented as follows: 
 

Danger 
symbol 

 

 SIGNAL WORD  

Type of danger and its source 

Possible consequences of violation. 

 Measure to prevent the danger. 

If a dangerous situation could arise at a specific step, the safety instruction is displayed 
immediately before this dangerous step and is shown as follows:  

 SIGNAL WORD 

Type of danger and its source. Possible consequences of violation. 

1. Measure to prevent the danger. 

Danger levels 

Signal words in the safety instructions specify the danger levels. 
   

 DANGER Will lead to severe injuries or death. 

 WARNING May lead to severe injuries or death. 

 CAUTION May lead to light to moderate injuries. 

NOTICE May lead to material damage. 

    
  

1 ABOUT THIS MANUAL  



 

 

PHG 80 portable About this manual 

822-165-2 7 / 50 

Danger symbols 
   

 
Warning about general danger 

 
Warning about electric voltage 

 
Warning about arcing faults 

   
 

1.3 View settings 
   

Symbol Meaning 

  You are requested to perform an action. 

1. 

2. ... 

Perform the actions in this sequence. 

a. 

b. ... 

If an operation consists of several operating steps, specify these with "a, b, c". 
Perform the operating steps in this sequence. 

1 

2 ... 

Numbering in the legend 

  List 

 

Indicates further information on the topic. 

   
 

1.4 Note on the screenshots and graphics used 

The screenshots and graphics used are intended to illustrate the procedure and may differ 
from the actual state. 
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We, the manufacturer, produce our devices and systems according to the latest 
technological standards and guarantee a high level of operational safety and reliability. 
However, responsibility for safe use lies with the responsible body1 and operator2. The 
responsible body and operator of the device or system are responsible for any injuries or 
damage resulting from non-compliance with this user manual. 

This chapter For your safety in this user manual is intended to help you implement the 
required safety measures. 

 

2.1 Operation by qualified personnel 

The system may only be operated by qualified personnel. Qualified personnel are individuals 
who, thanks to their professional electrical engineering training, are able to identify and 
prevent dangers, and who are qualified to perform the respective tasks. 

Before starting work, the responsible body and persons working with the system must have 
carefully read through and understood the user manual for the system, as well as the user 
manuals for all associated devices or systems. 

 

2.2 Intended use 

The PHG 80 portable VLF test system is used for cable and cable sheath testing of medium-
voltage cables up to 50 kV. 

The following diagnostic measurements are also possible in combination with the PD-TaD 
portable PD diagnostics system: 

 Dissipation factor and partial discharge measurements  

 Monitored Withstand Test with dissipation factor measurement (MWT with tan delta)  

 Full Monitored Withstand Test (Full MWT)   

If the system is not used in accordance with this stipulation, safe operation cannot be 
guaranteed. The manufacturer cannot be held liable for any damage to persons and property 
resulting from incorrect operation. 

 To ensure safe use as intended, follow the instructions in this user manual. 
 

                                                
1 Responsible body is the person or group that is responsible for the safe operation of the device and its 

maintenance (EN 61010-1, 3.5.12). 
2 Operator is the person who uses the device for its intended purpose (according to the definition of user in 

compliance with EN 61010-1, 3.5.11). 

2 FOR YOUR SAFETY 
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2.3 Avoiding dangers, taking safety measures 
 When erecting the test installations and operating PHG 80 portable, adhere to the latest 

applicable version of the following regulations and guidelines:  

 Accident prevention and environmental protection regulations applicable for your 
country  

 Safety instructions and regulations of the country where PHG 80 portable is being 
used 

 EU/CENELEC countries: EN 50191 Erection and operation of electrical test 
equipment 

Other countries: The standard for erection and operation of electrical test equipment 
applicable for your country 

 EU/CENELEC countries: EN 50110 Operation of electrical installations 

Other countries: The standards for operating electrical installations applicable in your 
country 

 Any other relevant national and international standards and guidelines 

 Local safety and accident prevention regulations 

 Employers’ liability insurance association regulations (if any)  
 

2.3.1 Operation only in a technical secure state 

Safety, function and availability depend on the proper condition of the system. 

 Operate the system and the integrated devices only in a technical perfect condition.  

 In case of damage and malfunction, immediately stop the system, mark it accordingly 
and have the faults rectified by appropriately qualified and authorised personnel.  

 Comply with the inspection and maintenance conditions. 

 Use only accessories and original spare parts recommended by BAUR. The use of spare 
parts, accessories and special facilities that are not tested and approved by BAUR could 
adversely affect the safety, function and characteristics of the product. 

 

2.3.2 No unauthorised modifications to the system 

Accessories and spare parts 

Upgrades, modifications or alterations to the system are strictly prohibited. 

 Use only accessories and original spare parts recommended by BAUR. The use of spare 
parts, accessories and special fittings that are not tested and approved by BAUR could 
adversely affect the safety, function and characteristics of the system.   

System configuration 

The system you receive from BAUR is preconfigured and ready for operation.  

Changes to the system configuration may be carried out only after approval from and if 
necessary, under the instruction of BAUR After Sales. Arbitrary changes to the system 
configuration can adversely affect the safety, functions and features of the system. Faults 
and problems that were caused due to unauthorised changes to the system configuration are 
not covered by the warranty.   
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Reinstallation of the BAUR Software 

The BAUR Software is preconfigured by the manufacturer according to your system. If the 
BAUR Software is not reinstalled properly, configuration data could be lost, and faults could 
occur. In this case, there is no guarantee that the system will function without problems.  

 Contact BAUR BAUR After Sales Service to check if it is actually necessary to reinstall 
the BAUR Software and if so, arrange for this to be done properly.  

Faults due to improper reinstallation of the BAUR Software are not covered by the 
warranty.  

External software 

You may only install software that is required for carrying out measurement tasks and that 
has been explicitly approved by the authorised person in the company. Only the system 
administrator is permitted to carry out all software installations. 

You are not permitted to install any additional programs without prior approval. This 
particularly applies for downloaded programs such as computer games, utilities, plug-ins for 
browsers, etc. 

Faults and any changes in system settings due to installed external software are not covered 
by the warranty.  

 

2.3.3 Checking and maintaining the safety devices and accessories 

The safety devices and accessories must be inspected regularly for proper condition and 
function. The system must not be operated in the case of defects or non-functional safety 
devices.  

The safety devices and accessories must not be changed, bridged or switched off.  
 

2.3.4 No operation during condensation 

Condensation can form in devices and systems due to temperature fluctuations and high air 
humidity, which in some components can result in leakage currents, flashovers and short-
circuits. 

 Always prevent condensation in devices. Temper the device and system before and 
during the measurements so that no condensation occurs. 

 

2.3.5 No operation in areas with risk of explosion and fire 

Measurements in direct contact with water, in environments with explosive gases and in 
areas with fire risks are not permitted. Possible danger areas include e.g. chemical factories, 
refineries, paint factories, paint shops, cleaning plants, mills and stores of milled products, 
tank and loading plants for combustible gases, liquids and solid matter. 

 

2.3.6 Dangers when working with electric voltage 

Personnel need to pay special attention and must be very careful while working with electric 
voltage.  

Before starting work: Observe 5 safety rules 

1. Disconnect the test object from all phases. 

2. Secure the test object against reconnection. 

3. Ensure that there is no voltage. 

4. Earth all phases of the test object and short-circuit them. 

5. Cover or cordon off adjacent live parts to prevent accidental contact and flashovers. 
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 DANGER 

Electric voltage  

Danger to life or risk of injury due to electric shock; risk of burns or 
electro-ophthalmia due to arcing faults.  

 Before commencing work, the operator must assess the risks for 
the specific working conditions. Protective measures are based on 
the risk assessment and must be followed at the workplace.  

 Connect the system as described in this user manual.  

The test object may still be live and carry dangerous voltage after the 
high voltage release has been deactivated.  

 Before removing the safety precautions, discharge, earth and short 
circuit all live parts.  

    
 

2.4 Special personal protective equipment 

Personal protective equipment based on the risk assessment for the relevant working 
conditions is part of the PHG 80 portable safety concept.  

 Observe the internal operating instructions and the safety instructions applicable in your 
country. 

 

The PHG 80 portable VLF test system is used for cable and cable sheath testing of medium-
voltage cables up to 50 kV. 

The following diagnostic measurements are also possible in combination with the PD-TaD 
portable PD diagnostics system: 

 Dissipation factor and partial discharge measurements  

 Monitored Withstand Test with dissipation factor measurement (MWT with tan delta)  

 Full Monitored Withstand Test (Full MWT)   
 

 
Information on the following subjects is given in the chapter Data sheet 
(on page 48): 

 Technical data 

 Available methods 

 Standard delivery 

 Accessories and options 

   
 

3 PRODUCT INFORMATION  
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3.1 Full illustration 

3.1.1 Front view 
   

 

   

No. Element Function 

1 PHG VLF HV generator Is used to generate: 

 VLF truesinus® voltage 

 VLF square wave voltage 

 DC voltage 

Further information: Chapter PHG 80 VLF HV generator (on page 13) 

2 Discharge and earth rod Is used to discharge and earth the test object 

3 SCU safety control unit Is used to switch on the system and to release the high voltage and 
deactivate the high voltage release 

Further information: Chapter SCU safety control unit (on page 14) 

4 Laptop Is used to control and set measurements as well as record and 
evaluate measurement data via the BAUR Software 

5 Connection cables Are used to connect the system to the test object and to perform 
measurements 

Further information: Chapter System connection cables (on page 15) 
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3.1.2 Ports on the back 

All ports on the back of the system are described below. The number of ports depends on 
the system configuration. 
   

 

   

No. Element Function 

1  port Is used to connect an optional external emergency off unit 

If no external emergency off unit is being used, this port is bridged with 
a jumper plug. 

2 Laptop port Is used to connect the laptop 

3 PD-TaD port Is used to connect the PoE cable for dissipation factor and PD 
measurement with the PD-TaD (option) 

4 Network port The network port is connected by the manufacturer. So as not to impair 
the system's function, do not alter the port. 

5 TD port Is used to connect the TD cable for dissipation factor measurement with 
the PD-TaD (option) 

   
 

3.2 PHG 80 VLF HV generator 

The VLF HV generator is used to generate voltages for cable and cable sheath testing: 

 VLF truesinus® and VLF square wave voltage 

BAUR VLF truesinus® digital technology offers load-independent voltage generation with 
digital control. The voltage is exact, symmetrical, and continuous. 

 Stabilised DC voltage with positive and negative polarity 

The VLF HV generator is controlled centrally via the BAUR Software. 
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3.3 SCU safety control unit 

The SCU safety control unit is used: 

 to switch the system on and off 

 to protect against unauthorised or unintentional restarting of the system 

 to switch off the system in an emergency using the emergency off button 

 to release the high voltage and to deactivate the high voltage release 
   

 

   

No. Element Function 

1 On/Off switch Is used to switch the system on and off 

2  key Changes the system to Ready to switch on operating state 

  key Deactivates the high voltage release and puts the system into the 
Ready for operation operating state 

3 Indicator lights Indicate the system operating state: 

 Green: Ready for operation 

 Red: Ready to switch on, In operation 

4 Emergency off button Moves the system to the Ready for operation operating state. 

The emergency off button is equipped with a key lock to protect against 
restart, unauthorised start-up, and unauthorised or unintentional 
operation. 
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3.4 System connection cables 
   

 

   

No. Cable Function 
Minimum bend 
radius 

1 HV connection cable Is used to connect the system to the test object 90 mm 

2 Mains supply cord Is used to connect the system to the mains voltage 59 mm 

3 Protective earthing cable Is used to connect the system to the protective 
earthing 

101 mm 

   
 

3.5 Rating plates 

3.5.1 Rating plate of the system 
   

 

   

Element Description 

BAUR System Indicates that it is a system with multiple components 

XX XXX XX XXX Serial number of the system 

BAUR GmbH 
Raiffeisenstrasse 8; 6832 Sulz / Austria 
Tel.: +43 / 55 22 / 49 41-0 
FAX: +43 / 55 22 / 49 41-3 
www.baur.eu; e-mail: headoffice@baur.eu 

Name and address of the manufacturer 
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3.5.2 Rating plate of the PHG VLF HV generator 
   

 

   

Element Description 

Type Device designation 

No. Serial number 

U Supply voltage 

If several supply voltages are possible, these are given consecutively one after 
another. 

 Not applicable here 

f Mains frequency 

VA Max. recorded apparent output 

 General warning sign 

Indicates that there is a potential risk of danger when using the product and hence 
the user manual must be observed 

 
CE mark 

Indicates that the device or system conforms to CE. 

BAUR GmbH 

6832 Sulz / Austria  

Name and address of the manufacturer 

Made in Austria Indicates the country in which the device was manufactured. 
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3.6 Operating states 

Out of operation  

 All safety measures necessary before stepping into the test area have been met.  

 All power supplies, signal and control electric circuits are switched off.  

Ready for operation  

 The safety measures of the Out of operation operating state that are necessary before 
stepping into the danger area are still in place.  

 The power supplies for the signal and control current circuits of the switching devices are 
switched on.  

 The test voltage supply is switched off and secured against accidental start.  

 The system's green indicator light lights up.  

Ready to switch on  

 All accesses to the test area are closed. The safety measures of the Out of operation 
operating state that are necessary before stepping into the danger area are lifted.  

 The test voltage supply is switched off.  

 The system's red indicator light lights up.  

In operation  

 All accesses to the test area are closed.  

 One or more test voltage supplies are switched on.  

 The system's red indicator light lights up.  

 

1. Operate the system only in a technical perfect condition.  

2. Check the system and mechanical connections for damage.  

3. Check other devices for damage that are not integrated in the system and that you 
intend to use.  

4. Check electrical connections and connection cables for damage.  

Use only undamaged connection cables.  

5. Regularly check that the safety devices and accessories are in good condition and 
working properly. 

This particularly applies for signal systems, emergency off units, earthing and short-
circuit devices and ports.  

 

4 SYSTEM CHECKS TO PERFORM BEFORE COMMISSIONING 
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 Observe the safety instructions in chapter For your safety (on page 8).  
 

5.1 Setting up the system 
 Comply with the applicable accident prevention regulations and local conditions.  

 Select the installation location for the system in such a way that  

 a stable position is ensured,  

 the system is easy to access for connection and operation purposes,  

 sufficient safety distances are maintained. You must comply with EN 50110 for the 
operation of electrical installations and EN 50191 for the erection and operation of 
electrical test equipment (EU/CENELEC countries) or the relevant standards 
applicable in your country.  

 

5.2 Establishing a de-energised state 

The following steps relate to the connection point and the far end: 

1. Disconnect the test object from all phases. 

2. Secure the test object against reconnection. 

3. Ensure that there is no voltage. 

4. Earth all phases of the test object and short-circuit them. 

5. Cover or cordon off adjacent live parts to prevent accidental contact and flashovers. 

6. Cordon off all metal parts or insulate with insulating safety plates. 

7. Make sure that all metal parts are earthed. 
 

5 CONNECTING THE SYSTEM  
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5.3 Safety instructions 
    

 
 DANGER 

Danger due to electric voltage, flashovers at the connection point, 
or arcing fault on connection 

Electric shock on touching live and active parts and due to residual 
charges and induction voltages; 

Burns, electro-ophthalmia, and hearing damage. 

 Use suitable personal protective equipment against electric shocks 
and arcing faults. 

 Observe the isolating distances. 

 Make sure that the workplace is de-energised. 

Further information: Chapter Establishing a de-energised state (on 
page 18) 

 You may touch the parts that were under voltage only if they are 
visibly earthed and short-circuited. 

      

 
 DANGER 

High electric voltage through potential increase 

A fault can cause flashovers in the device. In this case, a potential 
increase of the housing is possible due to high short-circuit currents.  

Danger due to the potential increase is reduced when a protective 
earthing is connected properly. 

 Connect the protective earthing carefully. The protective earthing 
cable should be as short as possible and of low impedance.  
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5.4 Connecting the system to the earthing 

The illustration shows an example of a connection diagram with a 1-phase test object. 
Connecting the system to a 3-phase system is similar.  

Required equipment 

Suitable discharge and earth rod (included in the standard delivery) 

 Observe the max. test voltage of the system. Further information: Chapter Data sheet 
(on page 48) 

Procedure 
   

 
   

1. Make sure that the connection point and the far end are prepared for the measurement 
tasks. 

Further information: Chapter Establishing a de-energised state (on page 18)  

2. Connect the protective earthing cable of the discharge and earth rod to the station earth.  

3. Unwind the system's protective earthing cable fully so that there are no loops. 

4. Connect the protective earthing cable to the station earth - as close as possible to the 
station earth connection.  

 



 

 

PHG 80 portable Connecting the system 

822-165-2 21 / 50 

5.5 Connecting the system for cable testing 

Connection diagram 

 Cable with 3 screened phases (on page 22) 

 Cable with 1 screened phase (on page 22) 

 Unscreened cable with 3 phases (on page 22) 

Procedure 

1. Make sure that the connection point and the far end are prepared for the measurement 
tasks. 

Further information: Chapter Establishing a de-energised state (on page 18)  

2. Earth the system. 

Further information: Chapter Connecting the system to the earthing (on page 20)  

3. Unwind the HV connection cable fully.  

4. The HV connection cable screen is used for the operational earthing. Connect the screen 
of the HV connection cable to the station earth. Select the location for connecting the 
screen to the station earth as follows:  

 as close as possible to the location where the test object screens are connected to 
the station earth, and  

 as close as possible to the location where the unconnected test object phases are 
connected to the station earth.  

5. Connect the HV connection cable to the test object phase to test.  

Observe the relevant connection diagram.  

6. Remove the earthing and short-circuit connection from the phase to be tested: at the 
connection point and at the far end.  

7. Make sure that the unconnected phases are earthed and shorted.  

8. If needed, connect the external emergency off unit. 

Further information: Chapter Connecting the external emergency off unit (on page 24) 

If you are not using an external emergency off unit, ensure that the jumper plug is 

inserted in the  port for the external emergency off unit.  

9. Connect the laptop to the Laptop port of the PHG 80 portable. Use the supplied Ethernet 
cable for this.  

10. Connect the system to the supply voltage. 

Further information: Chapter Connecting the system to the supply voltage (on page 24)  
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5.5.1 Cable with 3 screened phases 
   

 

   
 

5.5.2 Cable with 1 screened phase 
   

 

   
 

5.5.3 Unscreened cable with 3 phases 
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5.6 Connecting the system for cable sheath testing 

The illustration shows an example of a connection diagram with a 3-phase test object. 
Connecting the system to a 1-phase system is similar.  
   

 

   

1. Make sure that the connection point and the far end are prepared for the measurement 
tasks. 

Further information: Chapter Establishing a de-energised state (on page 18)  

2. Earth the system. 

Further information: Chapter Connecting the system to the earthing (on page 20) 

3. Make sure that the screens of all phases of the test object are disconnected from the 
station earth at both ends: at the connection point and at the far end.  

4. Unwind the HV connection cable fully.  

5. The HV connection cable screen is used for the operational earthing. Connect the screen 
of the HV connection cable to the station earth. Select the location for connecting the 
screen to the station earth as follows:  

 as close as possible to the location where the test object screens are connected to 
the station earth, and  

 as close as possible to the location where the unconnected test object phases are 
connected to the station earth.  

6. Connect the HV connection cable to the test object screen.  

7. Make sure that the unconnected phases are earthed and shorted.  

8. If needed, connect the external emergency off unit. 

Further information: Chapter Connecting the external emergency off unit (on page 24) 

If you are not using an external emergency off unit, ensure that the jumper plug is 

inserted in the  port for the external emergency off unit.  

9. Connect the laptop to the Laptop port of the PHG 80 portable. Use the supplied Ethernet 
cable for this.  

10. Connect the system to the supply voltage. 

Further information: Chapter Connecting the system to the supply voltage (on page 24)  
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5.7 Connecting the system for diagnostic measurements 

The following diagnostic measurements are possible in combination with the PD-TaD 
portable PD diagnostics system: 

 Dissipation factor measurement  

 Partial discharge testing  

 Parallel dissipation factor and partial discharge measurement (TD || PD measurement)  

 Monitored Withstand Test with dissipation factor measurement (MWT with tan delta)  

 Full Monitored Withstand Test (Full MWT)  
    

 
Information on connecting, commissioning and operating the PD-
TaD portable PD diagnostics system is provided in its user manual. 

     
 

5.8 Connecting the external emergency off unit 

The  port for the external emergency off unit is located on the connection panel on the 
back of the VLF test system. 

1. Remove the jumper plug. 

2. Connect the cable of the external emergency off unit to the  port. 

3. Place the external emergency off unit outside the test area so that it is easy to reach. 
 

5.9 Connecting the system to the supply voltage 
1. Earth the system. 

Further information: Chapter Connecting the system to the earthing (on page 20)  

2. Make sure that the mains supply earth is not isolated from the station earth.  

3. Make sure that the mains voltage matches the specifications on the rating plate.  

4. Connect the system to the mains voltage. If necessary, use a country-specific adapter 
with sufficient current carrying capacity. 

 

5.10 Securing the test area 
1. Mark out the path for pedestrians.  

2. Secure the connection cables, e.g. with cable bridges or rubber mats. The connection 
cables must be protected against damage and there must be no danger of people 
tripping.  

3. If the connection of the device obstructs test personnel and pedestrians, these 
obstructions must be clearly marked.  

4. Check that no-one is located in the vicinity of the test assembly (test area). 

5. The test area must be demarcated from workplaces and traffic in such a way that 

 except for the tester, no other person can remain in the test area, 

 except for the tester, no other person can access the prohibition zone, 

 persons standing outside the boundary cannot reach the operating elements of the 
test installations located inside the boundary. (EN 50191) 

The minimum height of individual boundaries must be 1 m or correspond to the local 
safety regulations and standards.  
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6. If the device is cordoned off from generally accessible areas only with ropes, chains or 
bars, the entire test assembly must be monitored during the test in compliance with EN 
50191. If the test assembly includes several local test areas, security guards must be 
appointed for each test area. But it is important that the testing personnel and the 
security guards understand each other well.  

7. Make sure that unauthorised persons cannot access the device and test area.  

8. Mark the test area and terminals clearly. It should be immediately apparent that cable 
testing or measurement tasks are being performed on the cable system.  

9. Make sure that unauthorised persons cannot access the connection point and the far 
end of the test object.  

10. Make sure that the workplace is de-energised, and that the connection point and the far 
end of the test object are prepared for the measurement tasks. 

Further information: Chapter Establishing a de-energised state (on page 18)  

 

 Observe the safety instructions in chapter For your safety (on page 8).  

Procedure 

1. Make sure that the system is connected properly. 

Further information: Chapter Connecting the system (on page 18) 

2. Switch on the system via the On/Off switch on the safety control unit. 

 The system status changes to the Ready for operation operating state. 

 The system's green indicator light lights up. 

3. Switch on the laptop. 

4. Start the BAUR Software 4. 

 The Dashboard opens.  

 After starting the BAUR Software, the system status is continuously monitored. The 
information and error messages are displayed at the top right of the screen - in the 
notifications bar. 

   

 
Information on the messages can be found in the user manual for the 
BAUR Software. 

    
 

6 COMMISSIONING THE SYSTEM 
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7.1 About cable testing 

During the cable testing, a voltage is applied between phase and screen for a specific period 
to test the insulation. The test is considered successful if no breakdown occurs. The test 
duration and the voltage are defined by applicable standards based on the insulating 
material. The following voltage shapes are available depending on the system configuration: 
DC voltage, VLF truesinus® and VLF square wave voltage. 

Note: Cable testing with DC voltage is not suitable for plastic-insulated cables (e.g. XLPE- or 
PE-insulated cables). This is due to the following reasons: 

 Space charges can occur in the insulation when DC voltage is applied. When the test 
object is put into operation again following cable testing and AC voltage is applied, it is 
often at these exact points that faults occur. 

 Conversely, weak points in the insulation may not be brought to the point of breakdown 
by DC voltage and are therefore not detected. In this case, cable testing results in a 
pass, even though the insulation is damaged. 

For plastic-insulated cables, we recommend a test with the VLF truesinus® voltage. 

Available types of cable testing 

The following types of cable testing are available to you: 

 Simplified cable testing with software support: Cable testing is performed using the VLF 
HV generator and is controlled via the BAUR Software without diagnostics function 
(CABLE FAULT LOCATION software module). Various settings are available, and the 
test results are displayed in the software and can be added to the report. However, it is 
not possible to perform a programme with different voltage steps. 

Further information: Chapter Performing simplified cable testing (on page 27)   

 Extended cable testing: Cable testing is performed using the VLF HV generator and is 
controlled via the BAUR Software with diagnostics function (TESTING AND 
DIAGNOSTICS software module). You can create a programme with voltage steps that 
are automatically tested. The test results are displayed in the software and can be saved 
as a report. 

Further information: Chapter Performing extended cable testing (on page 29)  
 

7 CABLE TESTING 
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7.2 Performing simplified cable testing 

Required equipment 
   

 
 During measurement, always wear ear protection to protect your 

hearing from loud banging noises. 

   

On the system 

1. Secure the test area and connect the test object properly. 

Further information: Chapter Connecting the system (on page 18)  

2. Switch on the system and start the BAUR Software. 

Further information: Chapter Commissioning the system (on page 25)  

3. Release the high voltage on the safety control unit. To do this, press the  button. 

The system status changes to the Ready to switch on operating state. The red indicator 
light comes on.  

In the BAUR Software 

CABLE FAULT LOCATION > Pre-location > Cable testing 

1. In the phase selector, click on the phase to test.  

 

2. If you want to change the settings for the test, click on the  symbol.  

Recommendation: If known, set the nominal voltage (U0/U) of the phase to be tested. If 
no nominal voltage is defined, the maximum test voltage is limited by the BAUR 
Software. 

Further information: User manual for the BAUR Software (press the F1 key) 

3. Click the Start measurement button. 

4. If required, change the target voltage in the Measurement dialog. 

5. In the Measurement dialog, click the Start measurement button. 

The system status changes to the In operation operating state. 

The voltage curve is displayed in the test diagram. The measurement is completed 
automatically: 

 after a breakdown or  

 after the set voltage holding time 

6. Observe the actual current displayed during measurement. If the actual current is too 
high, the target voltage cannot be reached. 

The cable test is considered successful if the target voltage has been reached and no 
breakdown has occurred within the preset time. 

7. To close the Measurement dialog, click the Close button.  

   

 
Information on the adjustable measurement parameters can be found 
in the user manual for the BAUR Software. 
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Next steps 

 If you do not wish to perform further measurements or if you want to connect another 
phase: Deactivating high voltage release (on page 36) 

 Inserting a test diagram into the report: Inserting a test diagram into the report (on page 
28) 

 Creating a report: Creating a report in the CABLE FAULT LOCATION software module 
(on page 35) 

 

7.2.1 Inserting a test diagram into the report 

1. If you want to insert the test diagram in the report, click the Insert graph in report 
button. 

 

2. Enter a name for the graph and click the OK button. 
 

7.2.2 Evaluating test results 

Breakdown takes place 

There is a cable fault. We recommend performing a cable fault location.  

No breakdown achieved 

 For extensive evaluation, observe the voltage and current values.  

   

Case Cause and further procedure 

Target voltage reached There is no fault in the tested phase. We recommend a VLF cable test in 
compliance with the applicable standards if this has not yet been performed.  

Target voltage not 
reached 

If the target voltage was not reached, the leakage current is too high. We 
recommend performing a cable fault location. 

   

 

Further information: Chapter Tips and tricks for the evaluation of measurements (on page 
34) 
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7.3 Performing extended cable testing 

Required equipment 
   

 
 During measurement, always wear ear protection to protect your 

hearing from loud banging noises. 

    

On the system 

1. Secure the test area and connect the test object properly.  

Further information: Chapter Connecting the system (on page 18)  

2. Switch on the system and start the BAUR Software.  

Further information: Chapter Commissioning the system (on page 25)  

3. Release the high voltage on the safety control unit. To do this, press the  button. 

The system status changes to the Ready to switch on operating state. The red indicator 
light comes on.  

In the BAUR Software 

1. Select a cable route (File > Select cable route or DASHBOARD > CABLE ROUTES 
area).  

2. Select TESTING AND DIAGNOSTICS > Measurement.  

3. In the phase selector, click on the phase to test.  

4. Select the desired sequence and click on Cable testing in the sequence overview.  

5. Click the Start measurement button.  

The system status changes to the In operation operating state.  

The measurement will be performed according to the saved programme. During the 
measurement, the current measured values are displayed and you can see which 
voltage step is currently being tested (green cursor) at any time.  

As soon as the measurement result is available for the first voltage step, the automatic 
evaluation for the entire sequence is displayed. As each voltage step is completed, the 
display is updated with each additional measurement within this sequence, whereby the 
poorest result prevails. Further information: User manual for the BAUR Software (press 
the F1 key)  

The test automatically finishes as soon as the defined test duration has elapsed.  

You can cancel the test at any time by clicking the Stop button. When the test is 
completed or if it is cancelled, the system will automatically switch to the Ready to switch 
on operating state.  

   

 
Information on the adjustable measurement parameters can be found 
in the user manual for the BAUR Software. 

    

Next steps 

 If you do not wish to perform further measurements or if you want to connect another 
phase: Deactivating high voltage release (on page 36) 

 Creating a report: Creating a report in the TESTING AND DIAGNOSTICS software 
module (on page 35) 
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8.1 About cable sheath testing 

The cable sheath testing is used to look for outer cable damage (sheath faults) and is 
recommended for new systems, after repairs and for periodic checks. 

While checking for mechanical faults, a DC voltage is applied between cable sheath and 
earth. This testing determines whether the leakage currents that occur are within permissible 
limits or whether they deviate significantly from standard values due to a sheath fault. 
   

 
Information on the test voltages for cable sheath testing can be found in 
the current versions of the following standards: 

 IEC 60229 

 IEC 60502 

 DIN VDE 0276-620/621 (CENELEC HD 620/621) 

   

Available types of cable sheath testing 

The following types of cable sheath testing are available to you: 

 Simplified cable sheath testing with software support: Cable sheath testing is performed 
using the VLF HV generator and is controlled via the BAUR Software without diagnostics 
function (CABLE FAULT LOCATION software module). Various settings are available, 
and the test results are displayed in the software and can be added to the report. 
However, it is not possible to perform a programme with different voltage steps. 

Further information: Chapter Performing simplified cable sheath testing (on page 31)  

 Extended cable sheath testing: Cable sheath testing is performed using the VLF HV 
generator and is controlled via the BAUR Software with diagnostics function (TESTING 
AND DIAGNOSTICS software module). You can create a programme with voltage steps 
that are automatically tested. The test results are displayed in the software and can be 
saved as a report. 

Further information: Chapter Performing extended cable sheath testing (on page 33)  
 

8 CABLE SHEATH TESTING  
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8.2 Performing simplified cable sheath testing 

Required equipment 
   

 
 During measurement, always wear ear protection to protect your 

hearing from loud banging noises. 

    

On the system 

1. Secure the test area and connect the test object properly. 

Further information: Chapter Connecting the system (on page 18) 

2. Switch on the system and start the BAUR Software. 

Further information: Chapter Commissioning the system (on page 25)  

3. Release the high voltage on the safety control unit. To do this, press the  button. 

The system status changes to the Ready to switch on operating state. The red indicator 
light comes on.  

In the BAUR Software 

CABLE FAULT LOCATION > Pre-location > Cable sheath testing 

1. In the phase selector select the phase that is connected to the test object screen. 

 

2. If you want to change the settings for the test, click on the  symbol. 

Recommendation: If known, set the nominal voltage (U0/U) of the phase to be tested. If 
no nominal voltage is defined, the maximum test voltage is limited by the BAUR 
Software. 

Further information: User manual for the BAUR Software (press the F1 key) 

3. Click the Start measurement button. 

The displayed settings are taken from the voltage assistant (Tools > Voltage assistant). 
You require administrator rights to change these settings.  

Further information: User manual for the BAUR Software (press the F1 key) 

4. If required, change the target voltage in the Measurement dialog. 

5. In the Measurement dialog, click the Start measurement button. 

The system status changes to the In operation operating state. 

The voltage curve is displayed in the test diagram. The measurement is completed 
automatically: 

 after a breakdown or  

 after the set voltage holding time 

6. Observe the actual current displayed during measurement.  

Cable sheath testing is considered successful if the test voltage is reached and remains 
constant, no breakdown takes place, and the leakage current does not exceed a defined 
value. This defined value depends on the sheath material, cable length and number of 
joints.  

When the test is completed or if it is cancelled, the system will automatically switch to the 
Ready to switch on operating state. 

7. To close the Measurement dialog, click the Close button.    
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Information on the adjustable measurement parameters can be found 
in the user manual for the BAUR Software. 

    

Next steps 

 If you do not wish to perform further measurements or if you want to connect another 
phase: Deactivating high voltage release (on page 36) 

 Evaluating test results: Evaluating test results (on page 32) 

 Creating a report: Creating a report in the CABLE FAULT LOCATION software module 
(on page 35) 

 

8.2.1 Inserting a test diagram into the report 

1. If you want to insert the test diagram in the report, click the Insert graph in report 
button. 

 

2. Enter a name for the graph and click the OK button. 
 

8.2.2 Evaluating test results 

Breakdown takes place 

There is a cable sheath fault. 

If possible, pre-locate the cable sheath fault. Additional fault location equipment is required 
for sheath fault location, e.g. a burn down transformer and a bridge measuring unit. Proceed 
as follows: 

1. Condition the cable sheath fault. Follow the instructions of the user manual for the 
respective burn down transformer. 

2. Carry out the Glaser measuring bridge measurement. Follow the instructions of the user 
manual of the respective bridge measuring unit. 

3. If the measuring bridge measurement did not produce any results, next, perform the 
Murray measuring bridge measurement. 

Note: In the HV network, consider the network structure and cross bonding (crossing of 
screens). If you are working on very long cables, it is recommended feeding the voltage 
from the cable end close to the fault.  

4. If pre-location with measuring bridge measurement is not possible, locate the cable 
sheath fault with a pin-pointing method. 

No breakdown 

 For extensive evaluation, observe the voltage and current values.  

Cable sheath testing is considered successful if the test voltage is reached and remains 
constant, no breakdown takes place, and the leakage current does not exceed a defined 
value. This defined value depends on the sheath material, cable length and number of 
joints.  

If increased leakage current was measured, there is a cable sheath fault. 

Further information: Chapter Tips and tricks for the evaluation of measurements (on page 
34) 
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8.3 Performing extended cable sheath testing 

Required equipment 
   

 
 During measurement, always wear ear protection to protect your 

hearing from loud banging noises. 

    

On the system 

1. Secure the test area and connect the test object properly.  

Further information: Chapter Connecting the system (on page 18)  

2. Switch on the system and start the BAUR Software.  

Further information: Chapter Commissioning the system (on page 25)  

3. Release the high voltage on the safety control unit. To do this, press the  button. 

The system status changes to the Ready to switch on operating state. The red indicator 
light comes on.  

In the BAUR Software 

1. Select a cable route (File > Select cable route or DASHBOARD > CABLE ROUTES 
area). 

2. Select TESTING AND DIAGNOSTICS > Measurement. 

3. In the phase selector, click on the phase to test. 

4. Select the desired sequence and click on Cable sheath testing in the sequence 
overview. 

5. Click the Start measurement button. 

The system status changes to the In operation operating state. 

The measurement will be performed according to the saved programme. During the 
measurement, the current measured values are displayed and you can see which 
voltage step is currently being tested (green cursor) at any time. 

If evaluation criteria are selected, the automatic evaluation for the entire sequence is 
displayed as soon as the measurement result is available for the first voltage step. As 
each voltage step is completed, the display is updated with each additional 
measurement within this sequence, with the poorest result prevailing. Further 
information: User manual for the BAUR Software (press the F1 key) 

If no evaluation criteria have been selected, you also need to observe the current and 

voltage curves (  view). In this view, you can create a graph and insert it in the report (

 button) at any time. 

The test automatically finishes as soon as the defined test duration has elapsed. 

You can cancel the test at any time by clicking the Stop button. When the test is 
completed or if it is cancelled, the system will automatically switch to the Ready to switch 
on operating state.  

   

 
Information on the adjustable measurement parameters can be found 
in the user manual for the BAUR Software. 
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Next steps 

 If you do not wish to perform further measurements or if you want to connect another 
phase: Deactivating high voltage release (on page 36) 

 Creating a report: Creating a report in the TESTING AND DIAGNOSTICS software 
module (on page 35) 

 

The following diagnostic measurements are possible in combination with the PD-TaD 
portable PD diagnostics system: 

 Dissipation factor measurement  

 Partial discharge testing  

 Parallel dissipation factor and partial discharge measurement (TD || PD measurement)  

 Monitored Withstand Test with dissipation factor measurement (MWT with tan delta)  

 Full Monitored Withstand Test (Full MWT)  
    

 
Information on connecting, commissioning and operating the PD-
TaD portable PD diagnostics system is provided in its user manual. 

     

 

 To enable easier evaluation of a measurement, the full screen view is available. 

In the full screen view, the test diagram and the cable image are displayed on the full 
screen; the other areas are hidden.   

 For detailed documentation of the measurement, you can: 

 insert a graph for a measurement in a report and 

 insert a comment regarding a measurement in the report. 
   

 
Information on full screen view, graphs, and commenting in reports can 
be found in the user manual for the BAUR Software. 

    

 

9 DIAGNOSTIC MEASUREMENTS 

10 TIPS AND TRICKS FOR THE EVALUATION OF 

MEASUREMENTS 
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11.1 Creating a report in the CABLE FAULT LOCATION software 
module 

You can create a report immediately after completing cable or cable sheath testing, or do so 
later. 

1. If not yet selected: Select a cable route (File > Select cable route or DASHBOARD > 
CABLE ROUTES area). 

2. Select CABLE FAULT LOCATION > Report. 

You can customise the report header, show and hide graphs of measurements, and 
record additional information. 

You can save the report in the software and export it as a PDF. You can also load earlier 
reports. 

   

 
Further information is provided in the user manual for the BAUR 
Software (press F1 key). 

   
 

11.2 Creating a report in the TESTING AND DIAGNOSTICS 
software module 
1. If not yet selected: Select a cable route (File > Select cable route or DASHBOARD > 

CABLE ROUTES area). 

2. Select TESTING AND DIAGNOSTICS > Report. 

You can adjust the layout of the report, show and hide measurement data, and record 
additional information. 

You can view earlier reports and export reports as PDFs or print them directly from the 
software. 

 

 
Further information is provided in the user manual for the BAUR 
Software (press F1 key). 

    

 

11 REPORT PREPARATION  
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12.1 Deactivating high voltage release 
1. If you do not wish to perform further measurements or if you want to connect another 

phase, deactivate the high voltage release on the safety control unit: To do this, press 

the  button.  

The system's green indicator light lights up.  

 DANGER 

Dangerous voltage on the test object and other live machine parts. Danger to life, 
risk of injury from high electric voltage. 

2. Before touching test object, discharge, earth and short-circuit the same: at the 
connection point and at the far end. 

You may touch the plant parts that were under voltage only if they are visibly earthed 
and short-circuited. 

3. To protect the system against restarting, press the emergency off button and remove the 
safety key.  

 

12.2 Taking the system and the test area out of operation 
   

 
 DANGER 

Electric voltage 

Electric shock on touching live and active parts and due to residual 
charges if earthing is removed too early  

 Disconnect the earth connections as the last connection of the test 
assembly. 

 Never disconnect the earth connections as long as power and 
other periphery connections are still connected. 

    

1. Deactivate the high voltage release on the safety control unit. To do this, press the  
button.  

The system's green indicator light lights up.  

 DANGER 

Dangerous voltage on the test object and other live machine parts. Danger to life, 
risk of injury from high electric voltage. 

2. Before touching test object, discharge, earth and short-circuit the same: at the 
connection point and at the far end. 

You may touch the plant parts that were under voltage only if they are visibly earthed 
and short-circuited. 

3. Switch off the system via the On/Off switch on the safety control unit.  

12 DECOMMISSIONING THE SYSTEM 
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4. To protect the system against restarting, press the emergency off button and remove the 
safety key. 

5. Exit the BAUR Software by clicking on the Exit menu item in the File menu.  

6. Shut down the laptop.  

7. To disconnect the system completely from the supply voltage, pull out the mains plug.  

8. Disconnect the connection cables in the reverse order.  

Important: Finally, disconnect the earth cable last.  

9. Clean the connection cables.  

10. Wind up the connection cables or clear them away.  

11. If necessary, remove the cordoning.  

12. Remove the earthing and the short-circuit on the test object only if no subsequent work is 
required and if the test object is to be put back into operation by the responsible 
individuals.  

13. Remove the barriers and marking of the test area. 
 

12.3 Exiting the measurement with the emergency off button 
during emergencies 
1. Press the emergency off button on the safety control unit.  

 The HV generator is switched off.  

 The system's green indicator light lights up.  

 No measurement can be performed as long as the emergency off button is pressed.  

 DANGER  

Electric voltage. Electric shock on touching live and active parts and due to residual 
charges, danger of arcing faults. 

The voltage indicator ceases to display a voltage once the emergency off button has 
been operated, but dangerous voltage may still be present at the test object. 

2. Before touching the test object, discharge, earth and short it: at the connection point and 
at the far end. 

You may touch the parts that were under voltage only if they are visibly earthed and 
short-circuited. 

Further information: Chapter Using the BAUR discharge and earth rod (on page 39)  

External emergency off unit  

If an external emergency off unit is connected, you can bring the system to a safe operating 
state at any time using the emergency off button on the emergency off unit.  

1. Press the emergency off button on the external emergency off unit. 

 The HV generator is switched off. 

 The system's green indicator light lights up. 

 No measurement can be performed as long as the emergency off button is pressed. 

 DANGER  

Electric voltage. Electric shock on touching live and active parts and due to residual 
charges, danger of arcing faults. 

The voltage indicator ceases to display a voltage once the emergency off button has 
been operated, but dangerous voltage may still be present at the test object. 

2. Before touching the test object, discharge, earth and short it: at the connection point and 
at the far end. 
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You may touch the parts that were under voltage only if they are visibly earthed and 
short-circuited. 

Further information: Chapter Using the BAUR discharge and earth rod (on page 39)  
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After a measurement is finished, dangerous voltage may still be present on the test object, 
which can lead to life-threatening injuries caused by electric shock or an arcing fault. 

 Before touching the test object, discharge, earth and short it: at the connection point and 
at the far end. 

 You may touch the plant parts that were under voltage only if they are visibly earthed 
and short-circuited. 

 Use suitable personal protective equipment against electric shocks and arcing faults. 

Procedure with the BAUR discharge and earth rod 

The procedure with the BAUR earth rod is the same. 

1. If not yet connected, connect the protective earthing cable of the discharge and earth rod 
to the station earth. 

2. Assemble the discharge and earth rod: Screw the hook onto the discharge part and the 
discharge part onto the handle. 

 

3. Only use the discharge and earth rod if its surface is clean and dry. If necessary, clean 
and dry the surface of the discharge and earth rod. 

4. Only ever use the black handle to hold the discharge or earth rod and make contact with 
the test object by touching it with the hook of the discharge and earth rod. 

Important: 

 Keep a distance of at least 50 cm from the protective earthing cable of the discharge 
and earth rod. 

 Observe the minimum discharge period in accordance with the capacitance of the 
test object. 

 
 

13 USING THE BAUR  DISCHARGE AND EARTH ROD 
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NOTICE  

Damage to the system due to improper handling 

The user is liable for damages caused due to repairs.  

 Never dismantle the system components. This may lead to damages. Inside the 
system components there are no components that could be serviced or repaired 
by the operator.  

 Repairs must be carried out only by personnel trained and authorised by BAUR.  

   
 

When an error message appears, proceed as follows: 

1. Check the supply voltage, the connection cables and earth cable.  

2. Check whether the system is in the required operating state.  

3. Restart the system. Proceed as follows: 

a. Deactivate the high voltage release on the safety control unit. To do this, press the 

 button.  

b. Switch off the system via the On/Off switch on the safety control unit.  

c. Disconnect the system from the supply voltage by pulling out the mains plug. 

d. Wait >10 seconds and then connect the system to the supply voltage again. 

Further information: Chapter Connecting the system to the supply voltage (on page 
24) 

e. Switch on the system via the On/Off switch on the safety control unit. 

4. Restart the laptop. 

Start the BAUR Software and check whether the error persists. 

5. If the fault occurs again, write down the error text and the procedure that caused the 
error to occur.  

6. Put the system out of operation and mark it accordingly.  

7. Contact your nearest BAUR representative.  

   

 
Further information on the error messages can be found in the user 
manual for the BAUR Software. 

     

 

14 ERRORS AND CORRECTIVE MEASURES 
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NOTICE  

Damage to the system due to improper handling 

The user is liable for any damage caused due to improper maintenance or care.  

 Never take apart the system and installed components. This can damage the 
device. There are no components in the system or other integrated components 
that can be serviced or repaired by the operator.  

 Maintenance tasks must be carried out only by personnel trained and authorised 
by BAUR.  

   
 

15.1 Maintenance intervals 
   

Component Interval Maintenance work 

General maintenance 
tasks 

Before each use Check the system and connection cables for physical 
damage 

 After each use Clean the system and connection cables and check for 
physical damage 

Laptop As required Clean the display  

   
 

15.2 Cleaning the system 
    

NOTICE 

Damage to the device may be caused by using the wrong cleaning agents 

 Do not use any abrasive, corrosive cleaning agents or strong solvents. 

 Ensure material compatibility. 

 Do not clean the product with acetone or thinner.  

 Never clean electrical devices with water. 

    

Required equipment 

 Mild detergent 

 Lint-free cleaning cloth 

15 MAINTENANCE AND CARE 



 

 

Maintenance and care PHG 80 portable 

42 / 50 822-165-2 

Procedure 

1. Before carrying out any maintenance or cleaning work, switch off the system and 
disconnect it from the supply voltage. 

Further information: Chapter Taking the system and the test area out of operation (on 
page 36)  

2. If required, clean the device surfaces with mild detergent and a lint-free cloth.  

NOTICE! Device damage due to leaking fluids. 

3. Do not allow liquids to leak into the devices.  
 

15.3 Checking and cleaning the connection cables and connection 
accessories 
   

NOTICE  

Damage to cable due to aggressive cleaning agents 

 Do not use any abrasive, corrosive cleaning agents or strong solvents. 

 Ensure material compatibility. 

 Do not clean the connection cables with acetone or thinner.  

  

Required equipment  

 Mild detergent  

 Lint-free cleaning cloth  

Checking and cleaning after each use  

1. Before carrying out any maintenance or cleaning work, switch off the system and 
disconnect it from the supply voltage. 

Further information: Chapter Taking the system and the test area out of operation (on 
page 36)  

2. Each time after using the system, clean all the connection cables used and wind them up 
or clear them away.  

3. Check the connection cables for damage. 

Cracks, breaks or other damage in the connection cable can damage the cable.  

4. If dirty, clean the connection accessories with a lint-free cloth. 

Dirty or corroded contacts can affect the measurement and are often the cause for 
device damage.  

Regular inspection  

 Before and after each time you use the system, check the condition of all the connection 
cables. If necessary, to do this, unwind the connection cables fully and check them for 
cracks, damage and dirt.  

 Regularly check all connection accessories for damage and dirt.  
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NOTICE 

Damage to the system due to incorrect transportation and improper storage  

 Transport and store the system so that it always remains in an upright position.  

 Protect the system and its components against strong vibrations, moisture and 
unauthorised access.  

 Comply with the ambient conditions specified in the technical data.  

Further information: Chapter Data sheet (on page 48)  

   
 

Warranty 

For warranty claims, please contact BAUR GmbH or your local BAUR representative. 
Improper use will render the warranty null and void. Wear parts are excluded from the 
warranty.  

After Sales 

For questions contact BAUR GmbH or your BAUR representative. 

 

BAUR GmbH 

Raiffeisenstr. 8 
6832 Sulz / Austria 
service@baur.eu 
https://www.baur.eu 
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The final decommissioning and disposal of the system must be carried out only in 
compliance with country-specific laws, regulations and standards.  

System components do not belong in the domestic waste.  

 Dispose of electrical system components in accordance with the applicable national 
regulations.  

 Dispose of the various system components in an environmentally friendly manner and in 
accordance with the applicable national regulations. 
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We  

BAUR GmbH 

Raiffeisenstr. 8 

6832 Sulz 

Austria  

declare, under our sole responsibility, that the product  

VLF test system 

PHG 80 portable 

to which this declaration refers, conforms to the following standards or standard documents:  

 Low Voltage Directive 2014/35/EC  

EN 61010-1:2010 

EN 61010-2-030:2010 

EN 50191:2010 

 EMC Directive 2014/30/EU  

EN 55011:2009 + A1:2010 

EN 61000-4-2:2009 

EN 61000-4-4:2004 + A1:2010 

 Environmental testing 

EN 60068-2-ff  

 

Signed: Dr. Markus Baur, CEO  

 

Sulz, dd.mm.2024 
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PHG 80 portable
BAUR VLF test system

The PHG 80 portable VLF test system is used for cable and cable sheath testing 
of medium-voltage cables up to 50 kV and offers three tried-and-tested voltage 
shapes: 

VLF truesinus® and VLF square wave voltage
BAUR VLF truesinus® digital technology enables the most reliable detection of 
damage and offers the comparability of measurement results by means of  
load-independent voltage generation with digital control. Unlike other voltage 
shapes, the voltage is exact, symmetrical and continuous. The cable length has no 
influence on the test level. Medium-voltage cables are tested with utmost care and 
in compliance with the standards. 

DC voltage
For DC voltage testing, e.g. for paper-insulated mass-impregnated cables, the 
PHG 80 VLF HV generator provides a stabilised DC voltage with positive and negative 
polarity of up to 80 kV. 

The PHG 80 portable satisfies the highest requirements with regard to safety, 
robustness, operational convenience and automation.

Functions

 ▪  Max. test voltage up to 57 kVrms 

 ▪  Cable testing according to: 
IEC 60502, DIN VDE 0276-620/621 
(CENELEC HD 620/621), IEC 60060-3, 
IEEE 400.2-2013, IEEE 400-2012

 ▪  Cable sheath testing according to IEC 60229

Features

 ▪  High-performance test generator with 3 kW

 ▪  Compact, in a 19” housing

 ▪  Control via laptop

 ▪  Load-independent, reproducible sinusoidal 
high voltage by means of VLF truesinus® 
testing technology

 ▪  Adjustable test frequency: 0.01 Hz – 1 Hz

 ▪  Automatic sequences and reporting

 ▪  Use of standardised diagnostics sequences 
for different applications and cable routes 
that can be accessed simply on site

 ▪  Automatic breakdown detection

 ▪  Burn mode or safe shutdown on breakdown

 ▪  Intuitive user interface in multiple 
languages adapted to the work flow

 ▪  Safety control unit in compliance with 
EN 50191

 ▪  Variable connection options to cable 
stations of different models

 ▪  Can be expanded in combination with the 
PD-TaD 62 or PD-TaD 80 to include:

 –  Dissipation factor and partial discharge 
measurements

 –  Monitored Withstand Test with dissipation 
factor measurement (TD-MWT)

 –  Full Monitored Withstand Test (Full MWT)

 Further details on the individual methods 
can be found in the BAUR Software 4 cable 
testing and diagnostics data sheet

Portable, high performance test generator 
with VLF truesinus® technology 

 ↗  3 voltage shapes in one device

 ↗  For medium-voltage cables of up to 50 kV operating voltage

 ↗  Convenient to operate with simple user guidance

BAUR GmbH · Raiff eisenstraße 8, 6832 Sulz, Austria · T +43 (0)5522 4941-0 · F +43 (0)5522 4941-3 · headoffi  ce@baur.eu · www.baur.eu

The figure is illustrative.



Data sheet: BAUR GmbH · 826-116-12 · 04.2024 · Subject to modificationsPage 2/3

Technical data

Output voltage

Frequency range 0.01 – 1 Hz

VLF truesinus®  ▪ 1 - 57 kVrms

 ▪ 1.4 – 80.6 kVpeak

VLF square wave 
voltage

1 – 80 kV

DC voltage  
(positive / negative)

1 – 80 kV

Max. capacitive load  ▪ Up to 20 μF 
 ▪ 1.2 µF @ 0.1 Hz @ 57 kVrms 

 ▪ 3 µF @ 0.1 Hz @ 38 kVrms 

 ▪ 4 µF @ 0.1 Hz @ 30 kVrms

Resolution 0.1 kV

Accuracy 1%

Output current

Output current  ▪ 1.8 mA @ 80 kV
 ▪ 60 mA @ 50 kV
 ▪ 90 mA @ 20 kV

Max. burn current 120 mA

Resolution 10 μA

Accuracy 1%

General

Power supply 220 – 240 V, 50/60 Hz

Option 100 – 120 V, 50/60 Hz  
(with external auto transformer)

Max. power 
consumption

3,500 VA

Reverse voltage protected Up to 16 kV

Degree of protection IP22

Dimensions  
VLF HV generator  
(W x H x D)

Approx. 755 x 850 x 991 mm (19", 15 RU)

Weight  
VLF HV generator 

Approx. 199 kg, incl. rack and connection cable

Ambient temperature 
(VLF HV generator)

-20°C to +55°C (from 45°C with reduction in 
performance)

Storage temperature 
(VLF HV generator)

-30°C to +70°C

Relative humidity Non-condensing

Safety and EMC CE-compliant in accordance with Low Voltage 
Directive (2014/35/EU), EMC Directive 
(2014/30/EU), EN 60068-2-ff Environmental 
testing

BAUR Software 4

Details about the BAUR Software 4 and the system requirements can be 
found in the data sheet for the BAUR Software 4.

Dissipation factor measurement*

VLF truesinus® 1 – 57 kVrms

Load range ≥10 nF

Measurement range 0.1 x 10-3 – 1,000 x 10-3

Accuracy 1 x 10-4

Resolution 1 x 10-6 (mean value of the dissipation factor)

Detection and 
compensation of 
leakage currents

Automatic

* In combination with the PD-TaD 62 or PD-TaD 80



Data sheet: BAUR GmbH · 826-116-12 · 04.2024 · Subject to modifications Page 3/3

Standard delivery

PHG 80 portable VLF test system:
 ▪  PHG 80 VLF HV generator

 ▪  SCU safety control unit

 ▪  Laptop incl.

 –  pre-installed BAUR software 4

 –  pre-installed Windows operating system

 –  carrying bag

 ▪  GDR 80-500 discharge and earth rod

 ▪  Ethernet cable, 3 m

 ▪  19” rack for PHG 80 portable incl. HV connection cable, earth cable  
and mains supply cord, cable lengths of 10 m respectively

 ▪  Set of 4 wheels for 19” rack, mounted

 ▪  Carry handle, 2 pcs

 ▪  User manual

Accessories and options

 ▪  External auto transformer, 110/230 V; 3.0 kVA

 ▪ BAUR Software 4 for office PC (office installation)

Optional software functions
 ▪  Mapping (available countries on request)

 ▪  GIS interface

Would you like to discover more about this product? 
If so, contact us: www.baur.eu > BAUR worldwide
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Raiffeisenstr. 8 
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